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Предисловие 
 
Геоинформационные системы (ГИС) в настоящее время стали 

неотъемлемым инструментом исследовательского процесса и визуа-
лизации его результатов во всех науках о Земле. Справедливым будет 
утверждение, что появление ГИС придало новый мощный импульс 
развития географическим наукам, благодаря которому они оказались 
в авангарде современных естественных наук. 

Последние 10–20 лет показали, что никакая научная и производ-
ственная деятельность, связанная с вопросами организации и регули-
рования пространства, не обходится без использования ГИС. Их ши-
рокое применение в государственном управлении, транспортной сфе-
ре, сельском хозяйстве, жилищно-коммунальном хозяйстве, геолого-
разведке, педагогике, коммерческой деятельности и многих других 
отраслях обусловило необходимость глубокого усвоения методик ра-
боты и получение навыков работы в ГИС различного целевого пред-
назначения любыми специалистами по наукам о Земле и смежным 
направлениям. 

Настоящее пособие посвящено работе с ГИС Golden Software 
Surfer (или просто Sufer). Эта ГИС относится к специализированным, 
то есть направленным на решение узкого круга задач, а именно, по-
строение и анализ двух- и трёхмерных моделей поверхности. Про-
грамма была впервые создана в 1985 году американской компанией 
Golden Software, одним из мировых лидеров в разработке научного 
графического программного обеспечения. Клиентами Golden Software 
являются исследователи из добывающих отраслей, инженеры, медики 
и ученые, а продукты компании используются в 125 странах мира и 
на всех континентах. Surfer стал первой программой компании, полу-
чившей широкую известность. Затем в 1986 году был создан Grapher, 
в 1990 – Map Viewer, в 1996 – Didger. 

Работа в ГИС Surfer рассматривается на примере версии 12.0, 
вышедшей в 2014 году. В предлагаемом пособии содержатся методи-
ки выполнения таких операций, как создание и совмещение карт изо-
линий, векторных карт, карт точек, трёхмерных моделей и других ви-
дов моделей поверхностей, вычисление объёмов и площадей, улуч-
шение качества изображения, построение профилей и трёхмерных 
графиков функций, обрезание изображений,  позволяющие студентам 
без труда научиться использовать для своих целей все возможности 
данной программы.  
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Тема 1. Основы работы в ГИС Surfer 
 
1.1 Интерфейс и начало работы в Surfer 
При первом запуске Surfer автоматически создаётся новое пустое 

окно (окно чертежа) Plot1 (рисунок 1). Окно плот-документа является 
тем рабочим пространством, внутри которого можно создавать сеточ-
ные файлы и карты, сопровождать их подписями и простыми графи-
ческими объектами (полигонами, прямоугольниками, эллипсами, 
символами и т. п.). 

 

 
 

1 – печатная страница, 2 – менеджер объектов, 3 – менеджер свойств,              
4 – непечатаемая область, 5 –название документа, 6 – главное меню;            

панели: 7 – стандартная, 8 – вид, 9 – рисование, 10 – карта;  
11 – горизонтальная и вертикальная управляющие линейки 

 
Рисунок 1 – Окно Plot 

 
Большую часть окна плот-документа занимает печатная страни-

ца. При отправке на принтер создаваемых в Surfer изображений 
обычно печатается только то, что помещается внутри этой страницы. 
По умолчанию открывается страница формата А4. Размер и ориента-
цию страниц можно выбрать командой File > Page Setup. Макси-
мальный размер страницы по умолчанию – 279 см по диагонали, есть 
возможность увеличения до 5 080 см. 
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Слева от печатной страницы находятся менеджер объектов и ме-
неджер свойств. Если при первом запуске Surfer один из них или оба 
отсутствуют, то следует выполнить команду View > Object Manager 
(Вид > Менеджер объектов) или View > Property Manager                  
(Вид > Менеджер свойств). Это важные инструменты управления соз-
даваемыми в окне плот-документа изображениями. Посредством их 
регулируются все элементы оформления создаваемых карт и поверх-
ностей (цвет, размер и форма изолиний, заливок, подписей, осей и 
др.). Без них нельзя обойтись в том случае, когда создаётся оверлей 
(т. е. наложение одной на другую) нескольких карт. 

 

 
 

Рисунок 2 – Окно Sheet 
 

Помимо окна Plot (Чертёж), открываемого по умолчанию при за-
пуске программы и предназначенного для визуализации графических 
объектов, существует также окно Sheet (Таблица). Для открытия но-
вого окна Plot выбирается команда File > New > Plot, для открытия 
окна Sheet – File > New > Worksheet. Окно Sheet (рисунок 2) предна-
значено для хранения тех данных, по которым будет построена карта. 

По умолчанию единицами измерения в Surfer (ширина линий, 
размер значков, шкала управляющих линеек и т. д.) установлены 
дюймы (Inches). Для того, чтобы дюймы заменить на сантиметры 
(cm), необходимо выбрать команду Tools > Options.  
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Рисунок 3 – Выбор сантиметров в качестве единиц измерения в Surfer 
 
В разделе General этого окна в последней строке Page units за-

менить Inches на Centimeters (рисунок 3). 
 
1.2 Подготовка данных для построения  
цифровых моделей и создание grid-файла 
В таблицу окна Sheet необходимо заносить XYZ-данные о каждой 

точке, то есть данные о значении её абсциссы (Х, как правило, запи-
сывается в первый столбик – А), ординаты (Y, как правило, записыва-
ется во второй столбик – В) и количественные значения какого-либо 
признака (или признаков) в данной точке (Z, как правило, записывает-
ся в третий и последующие столбики) (рисунок 2). Не допускается 
пропуск каких-либо значений для каких-либо точек. В первую строку 
таблицы можно записывать пояснения или обозначения. 

После ввода значений всех точек файл таблицы необходимо со-
хранить (File > Save as…). Стандартный формат для файлов таблиц 
Surfer – [.dat]. Именно этот тип файла рекомендуется выбирать при со-
хранении таблицы с введёнными  вручную значениями точек. Помимо 
этого, свои данные можно вводить и хранить в документе Microsoft 
Excel, так как Surfer последних версий без проблем работает с обоими 
его форматами – [.xls] и [.xlsx]. Также возможен импорт значений то-
чек, полученных в других ГИС-программах, например, при оцифровке 
изолиний. Таким методом можно получить файл, содержащий                
XYZ-данные от нескольких тысяч точек (для небольшой территории) 
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до сотен тысяч точек (при подробной оцифровке горизонталей круп-
ных территорий), чего нереально достичь при ручном вводе. 

Вообще, количество точек, достаточное для построения модели, в 
каждом случае определяется индивидуально. Оно зависит как от же-
лаемой подробности модели, так и от размера территории, а также от 
характера распределения картографируемого явления: например, 
климатические показатели изменяются значительно более постепен-
но, чем высоты рельефа, поэтому и количества точек, необходимых 
для построения модели распределения какого-либо климатического 
показателя, нужно гораздо меньше. Моделирование загрязнения от 
точечных стационарных источников тоже требует меньшего количе-
ства точек, чем от мобильных источников в городах, где загрязнение 
распространяется от сложно организованной системы большого ко-
личества линейных объектов. 

После того как создан файл с числовыми значениями рельефа в 
каждой точке, его нужно преобразовать в grid-файл – файл с точками 
в узлах геометрически правильной сетки. В качестве примера будем 
использовать данные таблицы 1, где дана информация о 20 точках, 
для каждой из которых известны прямоугольные координаты, абсо-
лютная отметка рельефа и абсолютная отметка уровня грунтовых вод. 

 
Таблица 1 – Пример исходных данных 
 

Номер 
точки X, м Y, м Абсолютная отметка 

рельефа, м 
Абсолютная отметка 

уровня грунтовых вод, м 
1 1 000 8 000 433,5 420,8 
2 1 500 6 500 335,0 326,7 
3 3 500 10 000 247,5 235,2 
4 3 500 7 500 343,1 339,3 
5 3 500 5 500 257,6 252,3 
6 1 800 2 500 262,2 249,1 
7 6 000 9 000 239,2 233,2 
8 4 500 7 500 436,8 432,4 
9 5 500 6 500 239,3 229,2 
10 6 500 4 000 271,2 260,9 
11 8 500 11 500 237 227,5 
12 8 000 8 500 428,7 419,2 
13 8 500 7 000 319 313,8 
14 7 500 6 500 290,1 285,9 
15 7 500 6 000 270 263,7 
16 12 000 9 500 440,7 434,1 
17 10 500 5 000 248 243,2 
18 9 500 2 000 244,6 234,6 
19 13 000 7 500 266,2 258,2 
20 12 000 4 500 306,1 296,9 
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Для создания grid-файла перенесём данные из таблицы 1 в табли-
цу Surfer и сохраним её под названием, к примеру, «Рабочие данные» 
с расширением [.dat] либо в таблицу Excel с тем же названием. Выбе-
рем в командной строке команду Grid > Data, и в открывшемся диа-
логовом окне выберем сохранённый нами файл и жмём кнопку От-
крыть Open Data (рисунок 4). 

 

  
 

Рисунок 4 – Диалоговое окно  
Open Data 

 
Рисунок 5 – Диалоговое окно  

Grid Data 
 
Появляется диалоговое окно Grid Data (рисунок 5), в котором мы 

выбираем основные параметры создаваемого grid-файла. В разделе 
Data Columns в верхнем левом углу окна мы выбираем, из каких ко-
лонок исходного файла «Рабочие данные» мы будем брать значения 
Х, Y и Z. Для начала построим сеточный файл по абсолютным отмет-
кам рельефа, поэтому для значений Z выбираем ту колонку, в кото-
рую помещены именно эти данные. В меню Gridding Method мы вы-
бираем алгоритм, по которому будет строится сеточный файл. В об-
щем случае будем выбирать вариант Kriging. Наконец, в строке Out-
put Grid File выбираем папку, в которую будет помещён созданный 
grid-файл (у него расширение [.grd]). Нажимаем ОК, и файл создаётся 
и помещается в выбранную папку (по умолчанию, в ту же папку, где 
хранится исходный файл с данными).  

Если предварительно поставить галочку на Grid Report (в верх-
ней правой части окна), то после создания файла на экран будет вы-
веден отчёт о нём, в котором будет содержаться большое количество 
статистических и других его характеристик. 
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1.3 Создание и редактирование карты изолиний  
Теперь на основе созданного grid-файла можно построить карты 

или объемные изображения. Для этого необходимо выбрать команду 
Map > New. Появится список возможных типов изображений              
(рисунок 6). 

 

 
 

Рисунок 6 – Виды доступных для создания карт в программе Surfer 
 

К основным из них, которые могут пригодиться на начальном 
этапе работы с Surfer, относятся: 

1. Base Map (Основная Карта) – любое изображение в обычных 
векторных и растровых форматах – [.jpeg], [.bmp], [.png], [.shp], [.tif], 
[.jpx], [.dxf] и многие другие.  Такие изображения могут использо-
ваться как подложка, на которую можно наложить, к примеру, со-
зданную карту изолиний. 

2. Contour Map (Контурная Карта) – карта изолиний. 
3. Post Map (Карта Точек) – создаёт карту исходных точек на 

основе файла с расширением [.dat] или [.xlsx]. 
4. Classed Post Map (Классифицированная Карта Точек) – то же, 

что и предыдущее, однако точки разделены на классы по величине 
показателя Z, и точки каждого класса показаны отдельным значком. 



 

11 
 

5. 1-Grid Vector Map (Векторная Карта) – карта, на которой 
векторами показаны направления изменения показателя Z. Длина век-
тора отражает интенсивность изменения показателя. 

6. Watershed Map (Карта водосборных бассейнов) – программа 
определяет местоположения линий водоразделов и делит территорию 
на бассейны. 

7. 3D-Wireframe (3D-Каркас) – объёмный каркас. 
8. 3D-Surface (3D-Поверхность) – объёмная поверхность. 
После выбора необходимого типа карты появляется диалоговое 

окно Open Grid, в котором необходимо выбрать файл, на основе ко-
торого и будет построена карта или поверхность, и нажать на кнопку 
Открыть. На странице в окне Plot появиться нужная карта. 

Если выбрать Contour Map, а в окне Open Grid выбрать создан-
ный файл Рабочие данные.grd, то в окне Plot появится карта изолиний 
(рисунок 7). 

 

 
 

Рисунок 7 – Карта изолиний, созданная  
по исходным рабочим данным в таблице 1 
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Рассмотрим возможности редактирования данной карты. Как 
видим, в Object Manager (Менеджере объектов) появился ряд эле-
ментов, имеющих отношение к нашему изображению. Для созданной 
в нашем случае карты это такие элементы, как:  

1) Map (вся карта в целом со всеми её элементами),  
2) Right Axis (правая ось),  
3) Left Axis (левая ось),  
4) Top Axis (верхняя ось),  
5) Bottom Axis (нижняя ось),  
6) Contours (собственно изображение). Убрав галочку напротив 

соответствующего элемента, можно его временно отключить. 
Если выделить тот или иной элемент (например, на рисунке 7 

выделен элемент Contours), то в нижележащем окне Property Man-
ager (Менеджер свойств) появляются инструменты для редактирова-
ния данного конкретного элемента. Рассмотрим эти инструменты. 
При выделении элемента Map в Менеджере свойств появляются сле-
дующие основные вкладки (рисунки 8–12): 

Вкладка View (Обзор) 
Здесь можно редактировать 

следующие характеристики: 
– Projection (проекция): 

можно выбрать один из двух ва-
риантов – Orthographic (ортого-
нальная, когда взгляд наблюда-
теля перпендикулярен плоскости 
изображения) или Perspective 
(перспективная), когда взгляд 
наблюдателя под углом к плос-
кости карты (рисунок 14); 

– Rotation (вращение) – 
можно задавать угол поворота 
карты против часовой стрелки; 

– Tilt (наклон) – можно зада-
вать угол наклона карты, когда 
используется перспективная 

проекция; при 90° проекция становится ортогональной, при 0° плос-
кость превращается в линию; 

– Field of View (поле зрения) – позволяет выбирать величину по-
ля зрения при перспективной проекции (рисунок 9). 

Рисунок 8 – Вкладка View  
элемента Map  
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Рисунок 9 – Проекции карты 
 

Вкладка Scale (Масштаб) 
– Proportional XY scaling 

(Пропорциональное масштаби-
рование) – если на данном пунк-
те стоит галочка, то при любых 
изменениях размеров осей, соот-
ношения их исходных длин бу-
дут сохраняться, если не стоит – 
можно менять размеры осей 
независимо друг от друга. 

Затем идут две группы пока-
зателей (первая для горизон-
тальной оси, вторая для верти-
кальной), включающих: 

– Map units per cm – количество единиц, которые будут отраже-
ны на оси (в нашем примере – метров) на 1 см оси; 

– Length (page units) – длина оси. 
Вкладка Limits (Границы)  
Здесь задаются значение 

начальных и конечных точек гра-
ниц карты по горизонтали (X) или 
по вертикали (Y). Если поставить 
галочку на Use data limits (исполь-
зовать границы данных), то грани-
цы карты будут проходить прямо 
по координатам самых дальних то-
чек соответствующих сторон. 

Рисунок 10 – Вкладка Scale  
элемента Map  

Рисунок 11 – Вкладка Limits  
элемента Map  
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Вкладка Frame (Рамка) 
Здесь задаются параметры рам-

ки вокруг изображения и его внут-
ренней заливки: 

– Style – сплошная или преры-
вистая, с выбором длины отдельных 
фрагментов; 

– Color – цвет рамки; 
– Opacity – степень насыщенно-

сти цвета; 
– Width – ширина рамки            

(от 0 до 1,27 см); 
– Pattern – стиль фоновой за-

ливки карты (без заливки, сплош-
ная, штриховая, точечная и др.); 

– Foreground color – цвет заливки; 
– Foreground opacity – степень насыщенности цвета заливки. 
При выделении элемента Right Axis (или любой другой оси – ле-

вой, верхней нижней – их свойства аналогичны) в Менеджере свойств 
появляются следующие основные вкладки (рисунки 13–16): 

Вкладка General (Общие)  
Состоит из трёх разделов – редактирование самой линии (Line 

Properties) оси, редактирование текста подписи оси и редактирование 
подписей точек на оси. 

В разделе Line Properties доступны изменения следующих пока-
зателей: 

– Style – стиль линии оси (отсутствие линии, сплошная линия, 
прерывистая с разным размером отрезков и т. д.); 

– Color – цвет оси; 
– Opacity – степень насыщенности цвета; 
– Width – ширина оси (от 0 до 1,27 см). 
В разделе редактирования текста подписи оси: 
– Text title – в поле рядом можно написать заголовок оси,                     

а нажатие кнопки с символом ∑ справа от поля позволяет вызвать ок-
но его редактирования; 

– Offset along axis – смещает текст заголовка оси вдоль оси; 
– Offset from axis – смещает текст заголовка поперёк оси; 
– Angle (degrees) – позволяет поворачивать заголовок на задан-

ный угол; 

Рисунок 12 – Вкладка Frame  
элемента Map  
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 – Font Properties – выбор 
шрифта, размера, цвета и других ха-
характеристик текста названия оси. 

В разделе редактирования под-
писей точек оси доступны: 

– Show – показать или скрыть 
подписи к точкам на оси; 

– Angle (degrees) – поворот 
подписей; 

– Offset from axis – расстояние 
от оси до подписей точек; 

– Label Format – формат чи-
сел, которыми подписываются дан-
ные – тип, количество знаков после 
запятой, разделение точками, пре-
фикс, суффикс и др; 

– Font Properties – оформле-
ние подписей: шрифт (Font), размер 
шрифта (Size), цвет шрифта и его 
насыщенность (Foreground color и 
Foreground opacity), цвет и насы-
щенность фона (Background color и 
Background opacity), курсив (Italic), 
полужирный (Bold), зачёркнутый 
(Strikeout), подчёркнутый Underline). 

Вкладка Ticks (Штрихи)  
Для редактирования штрихов, 

отмечающих на осях местоположе-
ния точек: 

– Style – местоположение 
штрихов: с внешней стороны оси 
(Outside), с внутренней стороны (In-
side), на самой оси (Cross) или от-
сутствуют (None). 

– Length – длина штриха. 
Первая группа этих показате-

лей – для основных штрихов, вто-
рая – для дополнительных, в этом случае добавляется ещё один пара-
метр – Minor ticks per major – количество дополнительных штрихов 
между двумя соседними основными. 

Рисунок 13 – Вкладка General  
элемента Axis  
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Вкладка Scaling (Масштабирование): 
– Axis minimum и Axis maximum – значение начала и конца оси; 
– Major interval – интервал между соседними подписанными 

значениями; 
– First major tick и Last major tick – первое и последнее подпи-

санное на оси значение; 
– Cross X axis at и Cross Z axis at – в каких точках данная ось 

пересекает соответственно оси X и Z (при наличии); 
– Reverse axis – поменять 

направление шкалы на противопо-
ложное (если от начала координат 
значения шкалы возрастали от 2 000 
до 11 000, то если поставить галоч-
ку на этот пункт, они будут от 
начала координат уменьшаться от 
11 000 до 2 000). 

Вкладка Grid Lines (Линии 
сетки) предназначена для редакти-
рования линий сетки, отходящих от 
данной оси. Здесь линии двух типов 
– основные (отходящие от подпи-
санных на оси значений или основ-

ных штрихов) и дополнительные, рас-
положенные межу основными (их ко-
личество задаётся на вкладке Ticks 
(показатель Minor ticks per major). 

Рисунок 14 – Вкладка Ticks  
элемента Axis  

Рисунок 15 – Вкладка Scaling  
элемента Axis  

Рисунок 16 – Вкладка Grid 
Lines элемента Axis  
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В данной вкладе Grid Lines сначала идёт группа параметров для          
основных линий, затем группа тех же параметров для дополнительных: 

– Show – показать или скрыть линии сетки 
– свойства Style, Color, Opacity и Width аналогичны таким же 

свойствам для, например, линий осей на вкладе General. 
Из свойств элемента Contour используются главным образом 

свойства вкладки Levels (рисунок 17). 
Вкладки Levels (Уровни): 
– Level method – выбор ме-

тода построения изолиний (вари-
анты: Simple – обычный, Loga-
rithmic – логарифмический, Ad-
vanced – вручную). При выборе 
варианта Advanced появляется 
кнопка Edit levels (Редактировать 
уровни), вызывающая окно Levels 
for Map  (рисунок 18), в котором 
можно установить изолинию для 
любого значения, её форму, цвет, 
толщину, насыщенность, наличие 
подписи на данной изолинии, цвет 
и другие характеристики заливки 
между изолиниями и т. д.; 

– Minimum contour и Maxi-
mum contour – минимальное и 
максимальное значения изолинии; 

– Contour interval – «шаг» 
изолиний; 

– Major contour every – ка-
кая каждая по счёту изолиния 
будет основной; 

– Fill contours – заполнить 
цветами промежутки между изо-
линиями; 

– Fill colors – выбрать цве-
товую гамму для заливки (нажа-
тие кнопки справа вызывает окно 
Colormap – (рисунок 19)); 

– Color Scale – активно только при применении заливки и вызы-
вает появление легенды к цветовой заливке (рисунок 20). 

Рисунок 17 – Вкладка Levels  
элемента Contours  
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Остальные параметры касаются основных и дополнительных 
изолиний, а также оформления подписей изолиний, редактирование 
их характеристик аналогично редактирования характеристик других 
линий и подписей, рассмотренных выше (Show labels – показать или 
скрыть подписи к изолиниям, Orient labels uphill – ориентировать 
подписи к изолиниям в одном направлении или в противоположных 
от осевой линии карты). 

В окне Levels for Map 
доступны следующие дей-
ствия (рисунок 18): Add – до-
бавить новую изолинию, зна-
чение которой посередине 
между значениями выделен-
ной и предыдущей изолинии; 
Delete – удалить изолинию. 

Щелчок на Level позво-
ляет выбрать минимальное и 
максимальное значение изо-
линий, а также интервал 

между соседними изолиниями; на Line – стиль, цвет и другие пара-
метры изолиний.  

Щелчок на значении или какой-либо характеристике конкретной 
изолинии позволяет изменить только её. 

В окне Colormap в ме-
ню Presets можно выбрать 
вариант цветовой раскраски 
карты. Кнопка Reverse поз-
воляет поменять чередова-
ние цветов от меньшего 
значения Z к большему на 
противоположное. Наличие 
ползунков на цветовой 
шкале и меню Color позво-
ляет устанавливать кон-
кретное значение цвета для 

конкретного значения диапа-
зона между изолиниями. 

Свойства цветовой 
шкалы легенды также отражаются в Менеджере свойств при выделе-

Рисунок 18 – Диалоговое окно  
Levels for Map 

Рисунок 19 – Диалоговое окно 
Colormap 



 

19 
 

нии этого элемента в Менеджере объектов (рисунок 20). К ним            
относятся: Line Properties – свойства линии контура шкалы (такие же, 
как рассмотренные свойства других линий), First – выбор того значе-
ния, какое по счёту будет первым подписано на шкале, Frequency – 
частота подписей (каждое первое значение, каждое второе и т. д.),            
на рисунке 20 подписано каждое второе значение шкалы; Angle (de-
gree) – угол поворота подписей значений; Font Properties и Label 
Format – характеристики шрифта и формата подписей данных, ана-
логичные рассмотренным выше. 

 

 
 

Рисунок 20 – Карта изолиний с использованием заливки и легендой 
 
Подписи к изолиниям можно размещать в ручном режиме: 

щёлкнуть правой кнопкой мыши по изображению карты и в выпада-
ющем контекстном меню выбрать пункт Edit Contour Labels… Далее 
при зажатой клавише Ctrl левой кнопкой мыши можно нажимать на 
любое место изолинии, где необходимо поставить подпись. Подписи 
также можно перемещать вдоль изолинии левой кнопкой мыши,              
а также удалять, выделив и нажав Delete. По окончании работы с 
подписями следует нажать клавишу Esc для сохранения изменений. 

В последних версиях программы Surfer значительно облегчено 
построение профиля по карте. Для этого необходимо щёлкнуть пра-
вой кнопкой мыши по изображению карты и в выпадающем кон-



 

20 
 

текстном меню выбрать пункт Add > Profile. Затем отметить на карте 
точки начала, изменения направления и окончания профиля, завер-
шив его построение двойным щелчком. Профиль будет сразу же              
создан под картой (рисунок 21). При этом в менеджере объектов по-
является два объекта – линия на карте, по которой построен профиль 
(элемент Base Profile), и сам профиль (элемент Profile) с двумя ося-
ми. Характеристики этих объектов можно изменять в менеджере 
свойств точно так же, как и других. 

 

 
 

Рисунок 21 – Добавление к карте профиля и масштабной шкалы 
 

Ещё одним дополнительным элементом является шкала масштаба 
(вызывается щелчком правой кнопки мыши на изображении и выбо-
ром команды Add > Scale Bar контекстного меню). В её свойствах 
можно задавать количество отрезков, длину одного отрезка, ось, для 
которой построена шкала, и т. д. 

Команда Measure (Измерение) из того же контекстного меню 
позволяет производить на карте измерения – длины построенного 
мышью прямого отрезка линии, длины ломаной линии целиком, пло-
щадь и длину периметра замкнутого контура, эти характеристики по-
казываются в специальном окне (рисунок 22). 
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Рисунок 22 – Измерение расстояний на карте с помощью команды Measure 
 
Вопросы для самоконтроля 
1. Какой формат файлов подходит для хранения данных, по кото-

рым строятся карты в Surfer? 
2. Каково назначение Менеджера объектов и Менеджера свойств? 
3. Как можно осуществить цветную заливку между изолиниями и 

создать к ней легенду? 
4. Какими свойствами обладают оси изображения? 
5. Как можно редактировать свойства отдельных изолиний? 
6. Можно ли менять масштабы осей независимо друг от друга? 
 
Практическая работа  1 
Создание и оформление карты изолиний 
Цель работы: научиться создавать карты изолиний по исходным 

точкам, освоить возможности оформления созданных карт. 
 
Задание: по данным таблицы 1 создать grid-файл и визуализиро-

вать его в Surfer в виде карты изолиний (Contour Map). Оформить 
созданную карту согласно следующим требованиям: 
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1. Цветная заливка, стиль заливки Forecast, синий цвет обознача-
ет самые низкие отметки высот. 

2. Изолинии проведены через каждые 5 метров. 
3. Каждая третья изолиния – основная (выделена), ширина основ-

ных изолиний 0,04 см; подписи основных изолиний размером 14 пт, 
шрифт Times New Roman, чёрного цвета. 

4. Изолинии показаны в интервале от 220 до 440 м. 
5. Второстепенные изолинии – цвет бордовый, ширина 0,03 см, 

подписи не показаны. 
6. Показана цветовая шкала, подписи на ней показаны для каждо-

го четвертого значения (220, 240, 260 и т. д.). 
7. Шрифт подписей на цветовой шкале – Times New Roman. 
8. Подписи на цветовой шкале – шрифт жирный, подчёркнутый, 

цвет тёмно-синий. 
9. Размер карты 16х13 см. 
10. Координатная сетка красного цвета. 
11. Подписи осей – «Ось Х» и «Ось Y». Эти подписи красного 

цвета, выполнены курсивом, размером 12 пт. 
12. Помимо основных (подписанных значениями) делений на 

всех осях, между ними имеются по 5 промежуточных. 
13. На карте проведён профиль (см. рисунок). Ширина линии 

профиля 0,05 см, цвет чёрный, подписана «Линия профиля» вдоль 
наклонной линии. 

14. Сам профиль тёмно-серого цвета, подписан «Профиль», оси 
подписаны «Высота» и «Расстояние» соответственно. На профиле ко-
ординатная сетка. 

15. Масштабная линейка состоит из 6 сегментов, подписи под уг-
лом, подчёркнуты. 

16. Наклонить карту вперёд, чтобы значение угла наклона было 
60–65 градусов. 
 
 

Тема 2. Создание двух- и трёхмерных моделей 
поверхности различных типов 
 
2.1 Типы моделей поверхности 
Кроме карты изолиний, методика создания которой рассмотрена 

в теме 1, в Surfer доступны и другие виды изображений (рисунок 23). 
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1. Карта точек (Post Map). На данной карте отображаются точки, 
в которых непосредственно были проведены измерения, которые лег-
ли в основу создания карты изолиний. 
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а – карта точек; б – классифицированная карта точек; в – векторная 
карта; г – карта водоразделов; д – 3D-каркас; е – 3D-поверхность 

 

Рисунок 23 – Типы моделей поверхности в Surfer 
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2. Классифицированная карта точек (Classed Post Map) – схожая с 
предыдущей, однако точки здесь разбиваются на диапазоны, и принад-
лежащие каждому диапазону точки отмечаются отдельным символом. 

3. Карта изображения (Image Map) – создаёт изображение в 
растровом виде, то есть, состоящим из пикселов, каждый из которых 
окрашен в соответствии со значением его высоты. 

4. Карта с оттенённым рельефом (Shaded Relief Map). 
5. Векторная карта (Vector Image) – состоит из направленных от-

резков (векторов, которые показывают направление и интенсивность 
изменения (снижения или увеличения) картографируемого показателя. 

6. Карта водоразделов (Watershed Map) – проводит линии водо-
разделов и тальвегов по представленным данным (оптимально для до-
статочно крупной территории). 

7. 3D Каркас (3D Wireframe) – трёхмерное изображение рельефа 
в виде каркаса. 

8. 3D Поверхность (3D Surface) – трёхмерное окрашенное в соот-
ветствии с выбранной цветовой гаммой изображение рельефа. 

Для создания такой карты необходимо выбрать команду             
Map > New > Post Map. В появившемся окне Open Data выбрать и 
открыть исходный файл с рабочими данными (НЕ grid-файл, а исход-
ный файл в формате [.dat], [.txt], [.xls] и т. д.). 

Оформление данной карты, как и в рассмотренных ранее случаях, 
осуществляется в менеджере свойств при выделении этой карты в ме-
неджере объектов (рисунок 24). 

Вкладка General (Общие): 
– Data file – показывает путь к 

папке, в которой хранится файл            
с данными, по которым была построе-
на данная карта; 

– X coordinates – показывается ко-
лонка, из которой были взяты координа-
ты X точек, отображённых на карте; с 
помощью этого свойства можно вы-
брать другую колонку для координаты 
Х, карта сразу же изменится в соответ-
ствии с новыми координатами Х; 

– Y coordinates – аналогично для 
координаты Y; 

– First Row – номер точки, начи-
ная с которой точки следует показы-
вать на карте; 

Рисунок 24 – Вкладка  
General для карты точек 



 

25 
 

– Last Row – номер точки, заканчивая которой точки следует пока-
зывать на карте (поставив галочку на All, можно вывести на карту все 
точки); 

– Frequency – выбор интервала, че-
рез который необходимо показывать 
точки: 1 – все точки, 2 – каждую вторую, 
3 – каждую третью и т. д.; 

– Connect points – соединить все 
точки последовательно линией; 

– Line Properties – свойства ли-
нии, которая соединяет точки. 

Вкладка Symbol (Символ): 
Marker Properties – свойства мет-

ки. К свойствам относятся: 
– Symbol – выбор символа из 

набора символов; 
– Symbol Set – выбор набора сим-

волов; 
– Fill Color – цвет заливки символа 

(если выбран символ с заливкой); 
– Fill opacity – степень прозрачно-

сти заливки; 
– Line color – цвет контура символа; 
– Line opacity – степень прозрачно-

сти контура символа; 
– Default angle (degree) – угол по-

ворота символов; 
– Sizing method – метод определе-

ния размера символа: возможны вари-
анты Fixed size – фиксированный раз-
мер (тогда в нижележащем свойстве 
Symbol sixe выбирается единый для 
всех меток размер) и Proportional – 
размер символа пропорционален его 
значению (тогда в нижележащем свой-
стве Proportional, нажав на кнопку 
Scaling, можно вывести окно Propor-
tional Scaling, где выбрать параметры 
масштабирования символов (размер ми-
нимального и максимального символа, 

Рисунок 25 – Вкладка  
Symbol для карты точек 

Рисунок 26 – Вкладка  
Labels для карты точек 
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метод масштабирования – линейный или квадратный корень); 
– Color column – показать разницу значений в точках цветом 

символа (необходимо выбрать или вариант None, когда эту функцию 
не использовать, или одну из колонок исходного файла, значения в 
которой и будут отражены цветом). Вариант цветовой раскраски и 
другие параметры можно выбрать в свойствах снизу – Color method и 
Symbol colors. 

Вкладка Labels (Подписи): 
– Worksheet columns – выбрать колонку в исходной таблице, 

значения точек в которой использовать в качестве подписей;  
– Position relative – местоположение подписи относительно сим-

вола (сверху, слева, справа, снизу, по центру); 
– Angle (degree) – угол поворота подписей; 
– Font Properties – прочие свойства подписей, аналогичные рас-

смотренным свойствам других подписей. 
Свойства классифицированной карты точек отличаются тем, что 

здесь вкладка Symbol отсутствует, вместо неё имеется вкладка 
Classes, в которой, нажав кнопку Edit Classes, можно вызвать окно 
Classes for Map, в котором задать параметры и значения диапазонов 
(рисунок 27) – число классов, границы классов, форма и размер сим-
вола и др. 

 

 
 

Рисунок 27 – Диалоговое окно Classes for Map 
 
Во вкладке General имеется пункт Show legend, поставив галоч-

ку на котором, можно вызвать легенду к карте.  К основным свой-
ствам вкладки General свойств легенды можно отнести: 

– Type – форма рамки вокруг легенды (нет рамки, закруглённая 
рамка, прямоугольная рамка); 

– Title text – записать заголовок к легенде; 
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– Reverse order – выбрать, в какой последовательности распола-
гать элементы легенды – от большего к меньшему или от меньшего к 
большему; 

– прочие стандартные свойства линий и подписей. 
Карты других типов открываются с помощью команды Map и 

выбора grid-файла. Каждый из них имеет некоторые индивидуальные 
свойства, большинство из которых схожи с уже рассмотренными и 
могут быть освоены самостоятельно. 

3D-модель поверхности обладает высокой наглядностью, что де-
лает возможным её использование в большом количестве учебных си-
туаций, особенно при обучении правильному чтению карты и плана с 
изолинейным представлением рельефа. Модель можно вращать и по-
ворачивать под самыми различными углами, для этого нужно её вы-
делить, нажать кнопку Trackball ( ) на панели инструментов, затем 
зажать курсором изображение и двигать мышью до нужного направ-
ления и угла поворота модели. 

При создании 3D-модели в менеджере объектов появляется но-
вый объект – ось Z (Z axis), в свойствах которой, помимо стандарт-
ных свойств, можно изменить поворот оси (Axis Plane), чтобы подпи-
си к ней хорошо читались при различных поворотах модели. 

Что касается свойств самой поверхности, то необходимо отме-
тить свойства во вкладках General, Mesh и Lighting. 

Вкладка General: 
– Show color scale – показать цве-

товую шкалу; 
– Upper – выбрать расцветку по-

верхности; 
– Show Base – показать основу – 

для лучшей визуализации заливается 
пространство между поверхностью и 
некоторой базовой плоскостью; 

– Properties – кнопка Edit Base 
Properties – позволяет редактировать 
свойства построенной основы 
(например, выбирать цвет). 

Вкладка Mesh (ячейка) позволяет 
рисовать на самой поверхности гори-
зонтальные и вертикальные координатные линии, выбирать их густо-
ту и оформление. 

Рисунок 28 – Вкладка  
General для 3D-модели 
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Вкладка Lighting (освещение): 
– Model – позволяет выбрать ва-

рианты None – отсутствие тени, каж-
дая точка поверхности освещена 
одинаково; Smooth – показ тени, ко-
торая будет образовывается на по-
верхности при заданном горизон-
тальном и вертикальном угле солнца; 

– Horizontal и Vertical – выбор 
значения соответственно горизон-
тального и вертикального угла 
солнца. 

 
 

2.2 Совмещение изображений 
Существует большое количество возможностей объединения не-

скольких изображений. Для этого необходимо последовательно выде-
лить в менеджере объектов элемент Map каждого из них, зажав кла-
вишу Shift на клавиатуре (так, чтобы все эти элементы совмещаемых 
карт, были выделены), и выбрать команду Map > Overlay Maps. 

 

 
 

 
Рисунок 30 – Примеры совмещения изображений 

 
Необходимо обратить внимание, что при совмещении изображе-

ний, происходит совмещение и в менеджере объектов, и элемент Map 
становится общим для всех совмещённых изображений. 

Рисунок 29 – Вкладка  
Lighting для 3D-модели 
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Большой интерес представляет возможность совмещения               
3D-модели и исходной карты (Base Map). Base Map – это растровое 
изображение в стандартном растровом формате, например, [.jpeg], 
[.png] и т. д. Открывается оно стандартным способом Map > New >           
> Base Map. Если это изображение представляет собой карту, изоли-
нии которой были оцифрованы, и по этим данным построен grid-
файл, то можно совместить 3D-модель и исходную карту, в результа-
те чего последняя также приобретёт трёхмерный вид (рисунок 31). 
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Рисунок 31 – Пример совмещения 3D-модели и фрагмента топоплана 

 

 
 

Рисунок 32 – Трёхмерная модель топоплана после отключения заливки 
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Теперь можно убрать заливку 3D-поверхности и оставить толь-
ко изображение на топоплане. Во вкладке Overlays в Менеджере 
свойств поверхности, в пункте Color modulation выбрать Use overlay 
color only (рисунок 32). 

Вертикальный масштаб 3D-модели можно увеличивать или 
уменьшать в Менеджере свойств на вкладке Scale объекта Map, в са-
мом последнем пункте. 

 
2.3 Обрезка изображений 
Процедура «обрезки» карт так, чтобы был изображён лишь её 

нужный фрагмент, называется бланкированием. В Surfer процедура 
бланкирования реализована не очень удобно и не так просто, как 
большинство других операций. Фактически, при бланкировании не 
происходит физической обрезки файла, а точкам, лежащим вне выбран-
ной области, присваивается определённое значение, при котором они 
или соответствующие им изображения не будут показаны на карте в 
окне чертежа. Например, процедура бланкирования часто необходима, 
когда исходные данные не имели «прямоугольного характера» (напри-
мер, вытянутая и искривлённая гряда). В этом случае программа всё 
равно строит прямоугольную карту, и в областях отсутствия исходных 
данных также строит изолинии по совершенно некорректно интерполи-
рованным данным. Поэтому, лишние области, где данные изначально 
отсутствовали, нужно «обрезать», или бланкировать. 

Предположим, что необходимо карту на рисунке бланкировать 
так, чтобы осталось изображение только выделенного фрагмента            
(рисунок 33). 
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Рисунок 33 – Фрагмент карты, который необходимо бланкировать (слева), 
и результат бланкирования (справа) 



 

31 
 

Эта задача решается с использованием команды меню                   
Grid > Blank. Для начала бланкирования необходимо щёлкнуть на 
карту правой кнопкой мыши и в контекстном меню выбрать Digitize. 
При этом курсор приобретёт форму крестика. После отметки первой 
точки бланкируемого полигона появляется окно Digitized 
Coordinates, куда заносятся автоматически координаты каждой отме-
чаемой точки (рисунок 34).  

 

 
 

Рисунок 34 – Окно Digitized Coordinates 
 
Далее курсором последовательно отмечаются все точки, которыми 

оконтуривается бланкированный полигон (на карте эти точки будут 
отмечаться красными крестиками). Координаты последней точки 
должны полностью совпадать с координатами первой  точки, поэтому 
лучше всего копировать первую строчку и вставить в последнюю. За-
тем необходимо сохранить эти данные, выбрав команду File > Save As 
в окне Digitized Coordinates. Файл сохраняется с расширением [.bln] 
(по умолчанию digitized.bln). 

Затем необходимо открыть окно Worksheet (Таблица), в котором 
открыть данный сохранённый файл. В первом столбце первой строки 
этого файла указывается количество узлов, из которых состоит поли-
гон (область бланкирования). Во втором столбце первой строки запи-
сывается значение 0 или 1 («флаг»). В случае, когда в качестве «фла-
га» использован 0, бланкируются (вырезаются) значения файла, рас-
положенные вне полигона; в противном случае бланкируются значе-
ния точек, лежащих внутри оконтуренного полигона. В последующих 
строчках указываются координаты узлов полигона. Их количество 
должно соответствовать значению, указанному в первой ячейке таб-
лицы. Полигон для бланкирования должен быть обязательно замкнут, 
то есть координата последнего узла должна совпадать с координатой 
первого. В примере на рисунке 33 следует заменить в первой стоке во 
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второй колонке 1 на 0 (чтобы бланкировалась область вне полигона, а 
не внутри него). Затем сохранить изменённый файл. 

Осталось создать бланкированный грид-файл. Выбираем команду 
Grid > Blank. В появившемся окне Open Greed выбираем исходный 
файл с данными, который необходимо бланкировать. Затем сразу же в 
окне Открыть выбираем сохранённый файл с расширением [.bln], 
содержащий сведения о координатах точек, которыми оконтуривали 
полигон. Сразу после этого появляется окно Save Grid As, в котором 
мы сохраняем уже изменённый бланкированный grid-файл. Необхо-
димо выбрать его название (по умолчанию out.grd) и папку, в кото-
рую его сохранить. 

После сохранения можно открыть этот сохранённый файл обыч-
ным образом (Map > New > Contour Map). Появится карта, на кото-
рой уже не будут показаны бланкированные области (рисунок 33). 

 
Вопросы для самоконтроля 
1. Какие виды изображений поверхности доступны для создания 

в Surfer? 
2. Какие специфические свойства присущи карте точек? 
3. В чём отличие карты точек от классифицированной карты то-

чек? 
4. Каким образом можно совместить трёхмерную модель рельефа 

и растровое изображение? 
5. Что означает «бланкировать файл»? 
 
Практическая работа 2 
Создание и совмещение основных  
типов изображений 
Цель работы: научиться создавать карты различных типов и 

трёхмерные модели поверхностей, их интерпретировать, а также сов-
мещать и оформлять. 

 
Задание:  
1. Создать карту точек и оформить её следующим образом: 
 а) точки отмечены большим жирным крестиком (Symbol 2 из 

набора GSI Default Symbols). Цвет крестиков красный, цвет границ 
крестиков голубой; 

 б) крестики повёрнуты под углом 45 градусов; 
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 в) метод задания размера – пропорциональный (то есть размер 
крестика пропорционален значению высоты в данной точке: чем 
больше высота, тем больше крестик). Установить размеры: для мини-
мальной отметки 0,3 см, для максимальной 0,8 см. Величину значения 
в точках можно показывать не только размером, но и цветом.              
Для этого в пункте Color column выбрать ту колонку, значения точ-
ки в которой будут отражены (в нашем случае это колонка С), и 
ниже, в пункте Symbol Colors, выбрать цветовую гамму для окраски; 

 г) включить подписи точек. Расположить их справа от точки и 
повернуть на 20 градусов. Цвет красный, подчёркнутый. 

2. Объединить карту точек с ранее созданной картой изолиний.  
3. В другом окне Plot построить остальные типы карт и трёхмер-

ных моделей самостоятельно. При этом для карты изображения 
(Image Map) выбрать цветную раскраску и цветовую шкалу. Обра-
тить внимание, что эта карта очень похожа на карту изолиний, однако 
она в растровом формате, а карта изолиний – в векторном. 

4. Освоить элементы оформления трёхмерной модели (цветовая 
гамма и шкала, наложение сетки, особенности освещения рельефа при 
различном вертикальном и горизонтальном угле Солнца, возможность 
выбора полной, стопроцентной освещённости модели, вращение моде-
ли, увеличение и уменьшение горизонтального масштаба, показ базы). 

5. Произвести объединения карт: 
 – карта изолиний + векторная карта; 
 – карта изолиний + карта водоразделов; 
 – 3D-модель + карта водоразделов; 
 – 3D-модель + карта изолиний + векторная карта. 
6. Произвести бланкирование файла так, как это показано на ри-

сунке 33. 
 

 
Тема 3. Улучшение качества изображений  
Математические преобразования и исчисления  
 
3.1 Фильтрация и сплайновое сглаживание 
Источником данных для создания карт являются зачастую оциф-

рованные изолинии бумажных карт и топопланов. При этом могут 
появляться различные артефакты или слабо приемлемые результаты 
на некоторых участках карты – пересечение изолиний, резкие углы и 
т. д. (рисунок 35) Причинами могут быть погрешность приборов, 



 

34 
 

ошибка измерений, ошибки оператора при вводе данных, негативные 
особенности интерполяции и т. д. Поэтому при появлении таких яв-
лений необходимо от них избавиться и привести карту к традицион-
ному виду. Для этого существует два метода – фильтрация и сплайно-
вое сглаживание. 

 

 
 

 

Рисунок 35 – Фрагмент топоплана (слева) и составленная на основе  
оцифровки изолиний карта (справа), на которой отмечены участки,  

требующие исправления 
 
Фильтрация осуществляется командой Grid > Filter. В появившем-

ся окне Open Grid необходимо выбрать файл, который планируется 
подвергнуть фильтрации. Появляется окно Grid Filter (рисунок 36). 

 
Рисунок 36 – Диалоговое окно Grid Filter 
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Здесь имеется возможность выбрать один из многочисленных ал-
горитмов фильтрации, конкретная сущность которых является пред-
метом разработки прикладных математиков и программистов. В ре-
альности обычно один и тот же файл подвергают процедуре фильтра-
ции несколькими способами (либо один файл последовательно не-
сколькими процедурами), а затем выбирают тот результат, который 
более приемлем для составителя карты (рисунок 37). После выбора и 
выделения мышью алгоритма необходимо задать имя нового файла и 
папку, куда он будет помещён после создания (Output Grid File).  
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Рисунок 37 – Результаты фильтрации grid-файла:  
слева – с помощью алгоритма Gaussian Low-pass,  
справа – с помощью алгоритма 9-node Averaging 

 
Второй способ – сплайновое сглаживание – доступен при выборе 

команды Grid > Spline Smooth. Появляется окно Open Grid, где 
нужно выбрать grid-файл, который будет подвергнут сглаживанию. 
Появится окно Spline Smooth (рисунок 38). 

 

 
 

Рисунок 38 – Окно Spline Smooth 
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Имеются два способа сплайнового сглаживания: с помощью сгу-
щения сетки (Insert Node) и путём перевычисления сетки (Recalc 
Grid). В первом способе новые узлы вставляются между существую-
щими узлами исходной сетки. Оригинальные значения узлов исход-
ной сетки сохраняются, а новые узлы вычисляются так, чтобы полу-
чить гладкую поверхность. 

Если сетка перевычисляется, то значения всех узлов сетки рас-
считываются заново. В этом случае можно как увеличить, так и 
уменьшить количество строк и столбцов сглаженной сетки относи-
тельно сглаживаемой. 

Сплайновое сглаживание может быть использовано для умень-
шения плотности сетки. Это используется в том случае, если перво-
начально была создана слишком густая сетка и построение карты по 
ней занимает слишком много времени. 

Другим применением сплайнового сглаживания является запол-
нение редкой сетки. Например, при построении карт по сети размером 
10 × 10 узлов контуры будут представлены как ломаные линии, то 
есть линии, состоящие из смежных прямолинейных отрезков. При 
увеличении плотности сети с помощью команды Grid > Spline 
Smooth до размера 50 × 50 узлов представление изолиний и графиков 
поверхностей будет гораздо более гладким, чем при сети 10 × 10. 

При выборе пункта Insert Nodes в окне Spline Smooth становится 
доступной группа Number Nodes to Insert (Количество узлов встав-
ки). Там можно задать какое дополнительное количество узлов можно 
ставить между существующими узлами в строках (Between Rows) и 
столбцах (Between Cols). 

Если выбрать пункт Recalc Grid (Перевычисление сетки), то ак-
тивной станет группа Final Grid Size (Конечный размер сетки). Здесь 
нужно указать конкретное количество столбцов, которое необходимо 
задать в сглаженном сеточном файле. Затем в пункте Output Grid File 
выбрать название файла (по умолчанию out.grd) и папку и нажать ОК. 

 
3.2 Исчисление площадей и объёмов 
В Surfer имеется возможность вычисления площадей и объемов. 

Можно вычислить объём между двумя поверхностями (например, меж-
ду поверхностью зеркала грунтовых вод и дневной поверхностью – то-
гда вычислится объём зоны аэрации, между подошвой и кровлей ка-
кого-либо горизонта – тогда вычислится объём этого горизонта и т. 
д.) либо между поверхностью и горизонтальной плоскостью, напри-
мер, объём между некоей заданной поверхностью (уровнем моря или, 
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к примеру, поверхностью с абсолютной высотой 100 м и т. д.) и днев-
ной поверхностью. 

Для вычисления объёма необходимо выбрать команду                   
Grid > Volume и в появившемся окне – файл сетки, которая будет яв-
ляться верхней поверхностью. Откроется диалоговое окно Grid Vol-
ume (рисунок 39). 

 

 
 

Рисунок 39 – Диалоговое окно Grid Volume 
 

Далее необходимо выбрать файл сетки, которая будет нижней 
поверхностью. Как для верхней, так и для нижней поверхности, меж-
ду которыми будет вычисляться объём, можно выбрать как grid-файл, 
так и какое-либо фиксированное значение координаты Z (выбирать 
фиксированное значение одновременно для верхней и нижней по-
верхности недопустимо). Затем нажать ОК.  

Программа откроет текстовый до-
кумент Grid Volume Computations 
(рисунок 26), в котором выдаст сооб-
щение о площадях и объёмах. Объём 
между верхней и нижней поверхно-
стью вычисляется тремя методами (ри-
сунок 40, раздел Volume, пункт Total 
Volumes By). 

Кроме того, в пункте Cut & Fill 
Volumes показывается отдельно объём 
выше выбранной нижней поверхности 
(Positive Volume), и ниже её (Negative 
Volume), а также разность между ними 
(Net Volume). 

В разделе Area приводится пло-
щадь территории. В разделе Planar Ar-
eas – площадь проекции на плоскость 

Рисунок 40 – Результаты  
вычисления объёмов  

и площадей 
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(Positive – выше заданной нижней поверхности, Negative – ниже её, 
Blanked – площадь бланкированных участков, Total – общая пло-
щадь). В разделе Surface Areas показана реальная площадь поверхно-
сти (чем более расчленён рельеф, тем больше эта величина при оди-
наковой площади проекции).  

Единицами измерения при вычислении объёмов и площадей слу-
жат квадратные и кубические единицы, которые использовались для 
обозначения координат точек при создании grid-файла. 

 
3.3 Математические преобразования grid-файлов 
Кроме вычисления объёмов и площадей, в Surfer можно произво-

дить математические операции с grid-файлами – складывать и вычи-
тать различные grid-файлы, осуществлять арифметические действия 
над всеми узлами сетки и т. д. 

Команда Grid > Math позволяет сгенерировать сеточный файл, 
значения которого вычисляются по значениям Z-координат узлов 
двух других сеточных файлов с помощью математических операций. 
Файлы, участвующие в операциях, должны иметь одинаковое число 
точек с одинаковыми координатами. Рассмотрим такую возможность 
на примере. Для этого обратимся к таблице 1. В ней помимо значений 
отметок рельефа для 20 точек представлены значения абсолютной вы-
соты уровня грунтовых вод для тех же 20 точек. Создав два grid-
файла (в одном в качестве координаты Z выступает абсолютная высо-
та рельефа, в другом – абсолютная высота уровня грунтовых вод), мы 
получим сеточные файлы с одинаковыми плановыми координатами 
точек, но разными координатами Z.  

Команда Grid > Math создаёт сеточный файл на основе заданной 
пользователем математической функции вида C = f(A,B), где A и B – 
входные grid-файлы, а C – выходной grid-файл. Заданная функция 
вычисляется над значениями узлов входных файлов с одинаковыми 
X-, Y-координатами, а результат вычислений помещается в выходной 
файл в узел с теми же X-, Y-координатами. 

Создадим новый grid-файл на основе двух вышеуказанных – вы-
соты рельефа и высоты уровня грунтовых вод. Если вычтем значения 
узлов второго файла от значений узлов первого, то мы получим            
grid-файл и соответственно карту изолиний, показывающих мощность 
зоны аэрации.  

Выберем команду Grid > Math. Появится окно Grid Math. С по-
мощью кнопки Add Grids… выбираем сначала grid-файл верхней по-
верхности (он будет обозначен как файл А), затем с помощью той же 
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кнопки добавляем файл нижней поверхности (файл В) (рисунок 41).    
В графе Enter a function of the form… вводим функцию, в соответ-
ствии с которой будет проведена математическая операция с выбран-
ными grid-файлами. В нашем случае вводим A – B. Задаём название и 
папку для создаваемого нового grid-файла и жмём ОК. 

 

 
 

Рисунок 41 – Диалоговое окно Grid Math 
 

В итоге получается карта, значения узлов которой заданы разно-
стью соответствующих значений улов первой и второй карт, и  изо-
линии показывают мощность слоя между дневной поверхностью и 
уровнем грунтовых вод (рисунок 42). 
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Рисунок 42 – Карта абсолютных отметок рельефа (а), карта абсолютных 
отметок уровня грунтовых вод (б) и результирующая карта, полученная 
путём вычитания значений узлов второй карты из значений первой (в) 

 
Команду Grid > Math можно использовать также для вычисле-

ния математических функций от одного сеточного файла. В этом слу-
чае заданная функция вычисляется для всех узлов входного файла. 
Например, можно построить сеточный файл, элементы которого яв-
ляются десятичными логарифмами от элементов входного файла 
(особенно если имеется очень сильный, на несколько порядков,           
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разброс значений координаты Z). Для этого нужно ввести в строку 
Enter a function of the form…  функцию C = log10(A). Или если вве-
сти функцию C = A – 50, то в результате получится файл, все элемен-
ты которого на 50 единиц меньше элементов входного файла. 

 
Вопросы для самоконтроля 
1. Какие существуют способы улучшение изображения в Surfer? 
2. Чем отличаются сгущение точек и перевычисление точек при 

выполнении сплайнового сглаживания? 
3. Как можно вычислить площади и объёмы по grid-файлу? 
4. Какие математические операции можно проводить над grid-

файлами? 
 
П рактическая работа 3 
С оздание карты  изолиний с помощью оцифровки 
топографической карты . М атематические  
исчисления и преобразования 
 
Цель работы: научиться корректировать карту изолиний различ-

ными способами, вычислять объёмы и площади по построенным мо-
делям, проводить математические преобразования моделей. 

 
Задание:  
1. В программе MapInfo оцифровать фрагмент топографической 

карты масштаба 1:25000. Для этого необходимо: а) зарегистрировать 
карту в реальных или условных координатах; б) обвести изолинии с 
помощью инструмента «Полилинии» и занести данные о высотах 
каждой изолинии в Список; в) разбить изолинии на точки с помощью 
утилиты Utillity.mbx и экспортировать значения координат точек вме-
сте со значениями их высот в файл [.txt].  

2. Создать grid-файл по значениям точек с помощью текстового 
файла. Создать карту изолиний, проанализировать качество изобра-
жения, определить участки карты, требующие исправления. Скоррек-
тировать изображение с помощью инструментов Filter (выбрав один 
из алгоритмов) и Spline Smooth (оба варианта – Insert Nodes и Recalc 
Grid), сохраняя каждый полученный результат под новым названием. 
Сравнить полученные результаты. Провести исправление карты пу-
тём использования нескольких инструментов последовательно. 
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3. Создать grid-файл по значениям абсолютных отметок уровня 
грунтовых вод (таблица 1). Отнять значения в узлах этого файла от 
значений в узлах с теми же координатами ранее созданного файла 
значений абсолютных отметок рельефа, как показано на рисунке 41. 
Полученный новый файл, отражающий мощность зоны аэрации, ви-
зуализировать в виде карты и 3D-модели. 

4. Вычислить площадь проекции поверхности рельефа, созданной 
согласно заданию 1 модели на плоскую поверхность, вычислить ре-
альную площадь самой поверхности. Вычислить объём между по-
верхностью и плоскостью с абсолютной отметкой на 3 м меньше, чем 
высота низшей точки модели. 

5. Вычислить объём между поверхностями моделей, указанных           
в задании 3. 

 
 

Тема 4. Создание производных карт  
и графиков функций  
 
4.1 Создание производных карт 
На основе созданной карты изолиний можно создавать производ-

ные карты, отражающие те показатели, которые программа может са-
мостоятельно рассчитать, используя исходный grid-файл (главным 
образом, связанные с вычислением углов и направлений наклона по-
верхности). Эти карты создаются с использованием команды            
Grid > Calculus и выбора исходного файла, по которому нужно будет 
строить производные карты. В этом случае появляется диалоговое 
окно Grid Calculus, которое разделено на четыре секции: 

I. Directional Derivatives (Дирекционные производные). Дирекци-
онные производные предоставляют информацию о наклоне или степени 
изменения наклона сеточной поверхности в указываемом направлении 
(задаётся дирекционным углом – пункт Direction диалогового окна 
Grid Calculus). В связи с учётом направления получаемые значения не 
обязательно соответствуют максимальным в данной точке. 

Имеется три вида дирекционных производных: First Derivative 
(Первая производная), Second Derivative (Вторая производная) и 
Curvature (Кривизна). Для каждого из них можно задавать дирекци-
онный угол. 
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1. First Derivative. Производит вычисление наклона поверхно-
сти вдоль указанного направления. Карты изолиний, построенные по 
результатам работы этого исчисления, изображают линии постоянно-
го наклона вдоль фиксированного направления. В любом конкретном 
узле сетки, если поверхность направлена вверх, её наклон положи-
тельный, а если вниз – отрицательный. 

2. Second Derivative. Производит вычисление степени измене-
ния наклона поверхности вдоль указанного направления. Карты изо-
линий, построенные по результатам работы этого исчисления, изоб-
ражают линии постоянной степени изменения наклона вдоль фикси-
рованного направления. 

3. Curvature. Кривизна – это мера степени изменения угла па-
дения касательной плоскости вдоль линии профиля, определённого на 
поверхности с помощью дирекционного угла. Кривизна представля-
ется своими абсолютными значениями и поэтому всегда больше нуля. 

II. Terrain Modeling (Моделирование террейна). Террейн – это 
изображение земной поверхности. Результаты моделирования бази-
руются на направлении градиента (направлении наибольшего наклона 
в данной точке), а не на заранее заданном направлении, как в случае 
дирекционных производных. 

При моделировании террейна можно использовать пять опера-
ций: Terrain Slope (Наклон террейна), Terrain Aspect (Аспект террей-
на), Profile Curvature (Профильная кривизна), Plan Curvature (Плановая 
кривизна) и Tangential Curvature (Тангенциальная кривизна). 

При выборе последних четырёх операций появляется строка 
Threshold (Порог). В областях, где наибольший наклон стремится к ну-
лю (где поверхность почти горизонтальна), трудно бывает определить 
направление градиента (т. е. направления «вниз» и «вверх» изменяются 
произвольно). В подобных случаях предпочтительнее поверхность 
классифицировать как плоскую. Порог Threshold – это минимальное 
значение наклона, для которого ещё вычисляются аспект и кривизна, 
это значение вписывается в окно данной строки. На участках, где значе-
ние Threshold не достигается, сетка бланкируется. По умолчанию порог 
Threshold устанавливается в очень маленькое значение: 

1. Terrain Slope. Производит вычисление наклона поверхности 
в каждом узле сетки. Получаемые значения – это угол, измеряемый в 
градусах, изменяющийся от 0 (горизонтальная поверхность) до               
90 (вертикальная). Для каждой конкретной точки поверхности наклон 
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террейна определяется по направлению самого крутого спуска или 
подъёма (аспект террейна). Наклон террейна подобен первой дирек-
ционной производной, но является более мощным инструментом, так 
как автоматически определяет направление наибольшего наклона. 

2. Terrain Aspect. Производит вычисление азимута направле-
ния «вниз» для наибольшего наклона (т. е. азимута падения) в каж-
дом узле сетки. Это направление всегда перпендикулярно контур-
ным линиям и точно противоположно направлению градиента. Зна-
чения аспекта террейна – это азимутальный угол, где 0º указывает 
на север, а 90º – на восток. 

3. Profile Curvature. Определяет степень изменения наклона 
поверхности в направлении градиента (против направления аспекта 
террейна) для каждого узла сетки. Профильная кривизна подобна 
второй дирекционной производной, но является более мощным ин-
струментом, т. к. автоматически определяет направление наибольше-
го наклона. Отрицательные значения указывают ускорение потока во-
ды, вылитой на поверхность. Положительные значения отмечают за-
медление потока воды. 

4. Plan Curvature. Отражает степень изменения угла аспекта 
террейна при рассмотрении его в горизонтальной плоскости и являет-
ся мерой кривизны изолиний на контурной карте. Отрицательные 
значения отмечают расхождение потока воды на поверхности, а по-
ложительные – схождение потока. 

5. Tangential Curvature. Измеряет кривизну в отношении вер-
тикальной плоскости, перпендикулярной направлению градиента или 
перпендикулярной изолинии на контурной карте. Отрицательные и 
положительные значения означают то же, что и у плановой кривизны, 
но значения кривизны другие. 

Две остальные секции – Differential and Integral Operators и 
Fourier and Spectral Analysis вычисляют довольно сложные показа-
тели, используемые главным образом в специализированных научных 
исследованиях. 

 
4.2 Создание графиков функций 
Программа Surfer позволяет стоить графики функций с двумя пе-

ременными вида z = f (y, x). Для этого предназначена команда              
Grid > Function. Появляется диалоговое окно Grid Function, где в 
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строке Enter a function… необходимо ввести функцию, используя 
специальную форму записи (таблица 2). 

 
Таблица 2 – Примеры записи некоторых функций 

 

Выражение Синтаксис для ввода в строку Enter a function… 

x2 pow(x,2) 

ln (x) ln(x) 

log10 (x) log10(x) 

1– ex (1-exp(x)) 
 (1-exp(-x×x)) 

 
1-(sin(x)/x) 

 
pow(x,2)/(1+(pow(x,2))) 

2x − x2 (2×x)-pow(x,2) 

(x3 + y3)(sin(8arctan (xy))) (pow(x,3)+pow(y,3))×(sin(8×atan(x×y))) 

 
Вопросы для самоконтроля 
1. Приведите пример записи функций в окне Grid Function. 
2. Какие типы производных карт можно создать в программе? 
3. Чем будут различаться карты, созданные с использованием ин-

струментов Second Derivative и Terrain Aspect? 
 
Практическая работа 4 
Создание карт углов наклона и графиков функций 
 
Цель работы: научиться создавать производные карты и графики 

функций. 
 
Задание:  
1. На основе grid-файла, созданного по данным таблицы 1, со-

здать производные карты: а) первая производная (направление 180°); 
б) вторя производная (направление 90°); в) наклон террайна; г) аспект 
террайна; д) профильная кривизна. 
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2. Создать графики следующих функций:  
– годовой показатель испаряемости: 
 

ЕМ = 0,0018(25 +  Т)2 × (100 – а), 
 
где Т – средняя месячная температура воздуха в 0С,  

 а – средняя месячная относительная влажность воздуха, %. 
– индекс увлажнения Высоцкого – Иванова  
 

К = r / Е0, 
 
где r – годовое количество осадков, Е0 – испаряемость;  
– радиационный индекс сухости (Будыко – Григорьева)  
 

К = В / L · r, 
 
где В – радиационный режим в ккал/см2 · год;  

L – удельная теплота парообразования = 0,6 ккал/см2,  
r – сумма осадков в г/см2 за год).  
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